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DIGSI 4.40 an alle Kunden ausgeliefert

Im August wurde DIGSI 4.40
(ursprünglich als Version 4.31
angekündigt) frei gegeben.
Mittlerweile wurden alle Kunden mit
der neuen Version beliefert.

DIGSI 4.40 unterstützt nun auch MS
Windows XP Professional Edition
(nicht Home Edition). Damit läuft
DIGSI 4 unter 6 Betriebssystemen –
von 95 bis XP!

Dass mit DIGSI mittlerweile alle
Schutz- und Feldleitgeräte von
Siemens egal welcher Version
eingestellt und bedient werden
können, ist nicht mehr neu. Doch
nun können Sie nicht nur einzelne
Geräte sondern gesamte Anlagen
aus DIGSI 3 nach DIGSI 4 in einem
Schritt konvertieren. Dabei werden
die hierarchische V3-Struktur und
auch die Geräteadressen übernom-
men. Nur ein paar Sekunden und
Sie können Ihre bisherige Anlage
mit DIGSI 4 bedienen. Leichter geht
es nicht mehr!

Unterstützt wird das neue
SIPROTEC 4 Geräte 7UT 612.

Endlich ist es möglich, einer
Gerätefunktionstaste eine
Menüebene der Frontbedienung
zuzuordnen, so dass Sie schnell und
ohne Aufwand einen individuellen
Menüeinsprung realisieren können
(siehe auch Fragen & Antworten).

Statt bisher 4 stehen Ihnen nun 255
COM-Ports für die Kommunikation
mit Ihren Geräten zur Verfügung.

DIGSI 4 kann nun auch in den
Sprachen Französisch und Spanisch
bedient werden.

SIPROTEC 4 StartUp

Seit eineinhalb Jahren wird „DIGSI 4
DEMO“, eine multimediale Präsenta-
tion von DIGSI auf CD-ROM, erfolg-
reich verteilt, ob aufgeklebt auf
Werbeseiten in branchenspezifischen
Zeitschriften, beigelegt als Add-On zu
DIGSI-Bestellungen oder persönlich
überreicht an Kunden und Schulungs-
teilnehmer: auf diese Weise haben
wir über 20000 Interessenten erreicht
und informiert.

Das gibt es nun auch für SIPROTEC 4,
eine "bewegende und bewegte"
Demonstration auf CD-ROM mit dem
Namen „SIPROTEC 4 StartUp“. Das
multimediale Tutorial erleichtert den
Start mit SIPROTEC 4: Mit Themen
wie „Installieren und in Betrieb
nehmen“, „Kommunikation mit DIGSI
vorbereiten“, „Beobachten,Testen und
Steuern“ und „Kommunikations-Mo-
dule tauschen“ werden die zentralen
Anwendungsbereiche einfach und klar

erläutert. Videoclips zeigen wie´s
geht. Details werden durch Sprecher
erklärt und zusätzlich in einem Textfeld
gezeigt, kurzweilige Musik läuft im
Hintergrund. Das Beste am Ende: die
hilfreiche CD-ROM ist kostenlos!

So erhalten Sie SIPROTEC 4 StartUp

Bestellen Sie die CD-ROM kostenlos
unter der Bestellnummer E50417-
A1174-C215-A1. Oder schreiben Sie
einfach formlos an
digsi@ptd.siemens.de.

http://siemens-russia.com/
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„Auf Gedeih und Verderb
ausgeliefert“

Immer wenn ein neues DIGSI zur
Freigabe ansteht, unsere SW-Ent-
wicklungsingenieure und -tester
schon an den meist überfälligen
Urlaub denken, laufen in der Aus-
lieferungsgruppe die Vorbereitungen
für einen reibungslosen Versand der
Software an alle lizenzierten Kunden
in der Welt auf Hochtouren. Die
Herren Posselt und Wenzl haben nun
keine freie Minute mehr, denn ihnen
obliegt die logistische und technische
Klärung im Vorfeld der CD-Produktion.

Anhand von Checklisten prüfen Sie
Fragen wie: Ist das für die Abliefer-
ungsprüfung zusammengestellte
Paket vollständig? Wurden Booklet,
Inlet und Label der CD-ROM an die
neue Versionsbezeichnung ange-
passt? Ist das Presswerk informiert?
Stehen genügend Mitarbeiter zur
Verfügung, um den Versand an 2500
Empfänger durchzuführen? Mit Frei-
gabe der neuen DIGSI-Version wird
der CD-Master an das Presswerk
übergeben. Bis die maschinell gefer-
tigten CD-ROMs aber eintreffen, kön-

nen bis zu 3 Wochen vergehen. In
diesem Zeitraum eingehende Bestell-
ungen werden trotzdem sofort 
bearbeitet: ein professioneller CD-
Brenner mit integriertem Label-
drucker macht´s möglich. Die Zeit bis
zur Versandaktion wird genutzt, um
die teilweise nötigen Zoll- und Ver-
sandpapiere fertig zu machen.
„Manche dieser Papiere müssen laut
Zoll händisch ausgefüllt werden“, klagt
Posselt über rückschrittlich wirkende
Vorschriften, die die Abwicklung der
Updateaktion erschweren.

Sind die CDs aus dem Presswerk
angekommen, wird nochmals ein
Schnelltest anhand einer Stichprobe
vorgenommen. Steht der Ausliefer-
ung nichts mehr im Wege, werden
alle verfügbaren Kräfte zusammen-
gezogen. Nach Arbeitsanweisung
werden die Versandtaschen gefüllt
und etikettiert. In einer Datenbank
wird genau festgehalten, welches
Päckchen wohin unterwegs ist. „Wir
wollen ja niemanden vergessen“, sagt
Wenzl , der zusammen mit seinem
Kollegen auch für die Adressdaten-
bank und ihre Pflege zuständig ist.
Und vergessen wurde wohl wirklich
noch niemand.Trotzdem kommt es
vor, dass Kunden verärgert die
Serviceline anrufen, weil sie das
Update nicht bekommen haben.

Vorgestellt

Dank der peniblen Datenpflege ist 
die Recherche meist von kurzer
Dauer, der Grund schnell ermittelt:
Die Firma wurde umstrukturiert,
Abteilungsbezeichnungen und
Zuständigkeiten geändert. So landen
Softwarepakete - wie vor 2 Jahren in
Zürich geschehen - beim Pförtner der
Firma. „Manchmal kommen Pakete
zurück, machmal verschwinden sie
irgendwo auf dem Weg“, weiß
Posselt, der nicht müde wird, auf die
Bedeutung der Registrierung der
Kundendaten hinzuweisen: „Sie
entscheidet nicht selten über Gedeih
und Verderb der ausgelieferten 
CD-ROM.“ Der Produktmanager
Reichenbach will das Updatever-
fahren daher so ändern, dass sich
ändernde Daten bekannt und erfasst
werden können.

Auch für den Versand anderer SW-
Produkte wie z.B. SICAM plusTOOLS
sind Posselt und Wenzl zuständig.
Die Arbeit wird nicht langweilig, die
Abwechslung macht Spaß. Das
merken auch die Kunden, die oft
telefonisch Beratung suchen: Die
Serviceline ist gut erreichbar – kein
Wunder: der eine ist Frühaufsteher,
der andere beginnt und beendet den
Arbeitstag spät.

http://siemens-russia.com/


3

Wer den Leistungsschalter über das
Abzweigsteuerbild des SIPROTEC-
Geräts schalten will, muss einige
Rückfragen quittieren. Soll der
Schalter über eine Funktionstaste
angesteuert werden, lassen sich
Anwender verschiedene Sicherungen
gegen versehentliche Betätigung
einfallen.

Eine Lösung sieht zur Sicherung 2
Funktionstasten vor. Die erste Taste
schaltet in den Steuermodus, die
zweite - innerhalb von 2 Sekunden
gedrückt - bewirkt das Schalt-
kommando.

Die Lösung ergibt sich direkt aus
dem Text: Die erste Funktionstaste
startet einen Timer. Für 2s steht an
seinem Ausgang QT1 ein Signal an,
dass über ein AND mit der zweiten
Funktionstaste verbunden ist. Wird
sie innerhalb dieser Zeit gedrückt,
wird der CFC-Ausgang „Befehl“
angesprochen.

Oft nachgefragt werden Lösungen,
die die zweimalige Betätigung ein–
und derselben Funktionstaste
innerhalb einer kleinen Zeitspanne
vorsehen.

Tipps & Tricks

Haben sich Ihre Adressdaten
geändert?

Dann schicken Sie einfach eine eMail
mit Ihrer Lizenznummer und den
geänderten Empfängerdaten an
digsi@ptd.siemens.de.

Hier ist man versucht, die obige Lö-
sung heranzuziehen und einfach nur
die 2. Funktionstaste durch die erste
zu ersetzen. Doch wird schnell
erkannt, dass schon beim ersten
Drücken der Funktionstaste der
Ausgang „Befehl“ auf high geht.
Das davon ausgehende Signal wirkt
gleichzeitig auf den Timer und das
AND. Wie lässt sich die Gleichzeitig-
keit auflösen, die zeitliche Abfolge
realisieren? Die Lösung ist denkbar
einfach, ja trickreich: das AND darf
nicht an 2. Stelle ablaufen. Nur wenn
das Logikgatter vor dem Timer läuft,

ist beim ersten Drücken der zweite
AND-Eingang noch 0 und damit auch
sein Ausgang. Doch nun läuft der
Timer für 2s. Wird in diesem Zeitraum
die F-Taste nochmals gedrückt, steht
die gewünschte 1 am AND, so dass
der Ausgang „Befehl“ auf 1 geht.

http://siemens-russia.com/
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Das Störschriebanalysetool SIGRA
setzt auf den genormten Standard
Comtrade und unterstützt somit auch
Störschriebe von Geräten, die nicht
von Siemens hergestellt wurden.
Hier bekommen Sie Tipps, wie Sie
mit diesen Störschrieben noch bes-
ser arbeiten können.

Die Benutzerprofile, die in der letzten
Ausgabe schon erwähnt wurden,
sind eine der mächtigsten Funktio-
nen von SIGRA. Mit den Benutzer-
profilen kann man sich ein eigenes
Layout abspeichern, man kann aber
sich auch das Arbeiten mit Stör-
schrieben anderer Hersteller ver-
einfachen.

Wenn Sie einen solchen Störschrieb
öffnen, so fragt SIGRA bei Fremd-
störschrieben nach, ob den Signalen
des Störschriebs eine physikalische
Bedeutung zugeordnet werden soll.
Bei SIPROTEC-Geräten erfolgt die
Erkennung automatisch.

Die Zuordnung dient dazu die Signale
für die Analysefunktionen zu identifi-
zieren. Nur wenn die Bedeutung der
Signale  bekannt ist, können Impe-
danzen oder Leistungen oder auch
die symmetrischen Komponenten
berechnet werden. Für die Bildung
des Nullsystems der Ströme eines
Dreileitersystems sind beispiels-
weise die drei Leiterströme notwen-
dig. Nur wenn diese vorhanden sind,
kann SIGRA das Signal berechnen,
nur dann wird es auch in der Rangier-
matrix angeboten.

Ordnen Sie die Signale des Stör-
schriebs zu den physikalischen
Größen zu. Als mögliche Signale
bietet SIGRA dabei die Leiter- und
den Erdstrom, bzw. Leiter-Erde-
Spannungen und Leiter-Leiterspan-
nungen. Fehlende Größen des Drei-
leitersystems werden, sofern es
möglich ist berechnet.

Definieren Sie anschließend ein
neues Benutzerprofil. Speichern Sie
dieses unter dem Namen des
Gerätes. Wenn Sie in Zukunft einen
Störschrieb des Gerätes öffnen, so
brauchen Sie die Kanäle nicht mehr
einzeln zuzuordnen, wählen Sie
einfach dessen Benutzerprofil aus.

Wenn Ihnen jetzt noch Signale
fehlen, die Sie für Ihre Analyse
benötigen, so können Sie diese
entweder in der Rangiermatrix finden
und zuordnen, oder wählen Sie eines
der vordefinierten Benutzerprofile
(„Ein Signal je Diagramm“ oder „Eine
Signalgruppe je Diagramm“ aus.
SIGRA initialisiert dann die
definierten Diagramme neu und
ergänzt sie um wichtige Größen.

Kennen Sie das Problem, dass Sie
den Maximalwert einer Kurve
messen wollen und es aufgrund der
Sinusverläufe der Signale ein wenig
schwierig ist den Punkt genau zu
treffen? Auch hier bietet SIGRA 4.2
eine Lösung.

Klicken Sie mit der rechten Maustas-
te in die Tabellenansicht. Das Kontext-

menü öffnet sich. Wählen Sie den
Punkt „Ansichtseigenschaften“.

In dem folgenden Dialog können Sie
Spalten auswählen, die in der Mess-
werttabelle angezeigt werden sollen.
U.a. finden Sie hier den Eintrag
„Letzter Extremwert“. Wählen Sie
diesen aus und übernehmen ihn in
die Liste der ausgewählten Spalten.

Die Messwerttabelle enthält jetzt
eine neue Spalte in der immer der
letzte Extremwert (Minimum oder
Maximum), der links vom jeweiligen
Cursor liegt angezeigt wird. Damit
können Sie sehr einfach die lokalen
Maxima und Minima bestimmen.

Wenn Sie mit dem SIGRA-Profil 
„Ein Signal ja Diagramm“ arbeiten,
dann kennen Sie bestimmt das
Problem, dass nach einigen Zoom-
schritten die Diagramme unterschied-
liche Achseneinteilungen besitzen.
D.h. ein Stromdiagramm geht von -
1,2A bis 2A, ein anderes von -0,4 
bis 0,6.

Wenn Sie alle Diagramme wieder
auf einheitliche Maßstäbe bringen

http://siemens-russia.com/
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Hier handelt es sich um einen
bekannten Fehler. Die Kopie/Variante
muss einmal mit DIGSI geöffnet
werden. Erst dann liefert der Ver-
gleich zuverlässig das richtige
Ergebnis.

Ich suche nach einer Möglichkeit,
über die Funktionstasten am Gerät
in bestimmte Menüebenen einzu-
springen. In der Rangiermatrix habe
ich hierzu nichts gefunden.

Mit DIGSI 4.40 ist es endlich mög-
lich, einer Gerätefunktionstaste eine
Menüebene der Frontbedienung
zuzuordnen. Öffnen Sie dazu die
Rangiermatrix des Geräts. Wählen
Sie dann im Menü „Extras“ den
neuen Punkt „Funktionstasten
einstellen“. Im gleichnamigen Dialog
selektieren Sie zunächst die
betreffende Funktionstaste aus der
Klappliste. Unterhalb kreuzen Sie die
gewünschte Menüebene an.

Auf manchen Rechnern lässt sich
die V2-Gerätebearbeitung (DOS-
DIGSI) nicht starten, unter Windows
XP stürzt sie gar ab.

Dies liegt an einer falschen Ein-
stellung der zu Grunde liegenden
DOS-Anwendung unter Windows.
Öffnen Sie den Explorer und selek-
tieren Sie im Pfad x:\...\Digsi4\Digsi2
(x steht für das Laufwerk, auf dem
DIGSI installiert ist) die Datei
"dosdigsi.exe". Öffnen Sie die
Eigenschaften (Klick mit rechter
Maustaste) und stellen Sie auf der
Karte „Sonstiges“ die Leerlauf-
aktivität  auf „Hoch“ ein. Unter
Windows XP wählen Sie zusätzlich
auf der Karte "Kompatibilität" die
Option "Windows 95".

Ich habe im Manager von einem
Gerät eine Variante erstellt. Obwohl
ich nichts geändert habe, findet der
Off-/Offline-Vergleich bis zu 1000
Unterschiede.

Fragen & Antworten

wollen, so gibt es eine schnelle
Methode: Wählen Sie im Menü
„Bearbeiten“ den Menüpunkt 
„Alles markieren“ aus, bzw. drücken
Sie <Strg>+<A>.
Danach <Strg>+<Shift>+<A>“, bzw.
im Menü „Ansicht“ unter „Zoom“
den Punkt „Anpassen“. Alle Diagram-
me werden jetzt so umskaliert, dass
alle Achsen den gleichen Maßstab
besitzen. Diese Funktion ist auch in
anderen Ansichten vorhanden, also
z.B. in der Zeigeransicht oder bei den
Harmonischen.

Möchten Sie Ihren Störschrieb für
Ihre Dokumentation kommentieren?

SIGRA bietet hier zwei verschiedene
Möglichkeiten an.

Das Comtrade-Format sieht für
Kommentare eine Datei vor. Diese
können Sie mit SIGRA editieren. Sie
finden den entsprechenden
Menüpunkt „Kommentar“ im Menü
„Bearbeiten“. DieserText wird auf der
ersten Seite des Störschriebs
ausgedruckt. Wenn Sie den Fehler
genauer mit Anmerkungen versehen
wollen, so bietet sich noch eine
andere Möglichkeit. Stellen Sie den
Cursor 1 an die Stelle in der
Zeitsignalansicht, an der Sie einen
Kommentar anbringen möchten.

Wählen Sie dann im Menü
„Einfügen“ den Eintrag
“Statussignal“. Sie haben jetzt die
Möglichkeit einen kurzen Text
einzugeben. An der angegebenen
Stelle wird dann eine Markierung in
den Störschrieb gesetzt.

http://siemens-russia.com/
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Demnächst

Die nächsten DIGSI 4 Notes

Der nächste Newsletter erscheint im
Dezember. In den Tipps & Tricks
dieser Ausgabe zeigen wir
Anwendungen von Zählern. Ein
weiterer Schwerpunkt ist die
Fernkommunikation mit SIPROTEC-
Geräten aller Versionen. In diesem
Zusammenhang lernen Sie auch
gleich unseren
Kommunikationsspezialisten kennen,
den wir Ihnen vorstellen.

http://siemens-russia.com/
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Topics
DIGSI 4.40 shipped to all customers

DIGSI 4.40 was released in August
(originally announced as Version
4.31). The new version has now been
delivered to all customers.

DIGSI 4.40 now also supports MS
Windows XP Professional Edition
(not the Home Edition). So DIGSI 4
runs under 6 operating systems –
from 95 to XP!

It's nothing new that DIGSI can be
used to set and operate any
versions of protection devices and
bay controllers from Siemens. But
now you can convert not only
single units but entire substations
from DIGSI 3 to DIGSI 4 in one
step.The hierarchical V3 structure
and the device addresses are
retained. In just a few seconds,
you can operate your previous
substation with DIGSI 4. It couldn't
be easier!

The new 7UT 612 SIPROTEC 4
devices are supported.

At last it is possible to assign a
front operation menu level to a
device function key, enabling fast
and effortless implementation of
customised menu entry (see also
Questions & Answers).

Instead of the previous 4, you can
now use 255 COM ports for
communication with your devices.

DIGSI 4 can now also be operated
in French and Spanish.

SIPROTEC 4 StartUp

For a year and a half now, we have
successfully been distributing "DIGSI
4 DEMO", a multimedia presentation
of DIGSI on CD-ROM, glued into
advertising pages in industry
journals, enclosed as a freebie with
DIGSI orders, or personally handed
to customers and training
participants. We have reached and
informed about 20,000 prospectives
in this way.

Now, we also have an "animating
and animated" demo CD-ROM for
SIPROTEC 4, called "SIPROTECT 4
StartUp".The multimedia tutorial
makes it easier to get started with
SIPROTEC 4.The core applications
are explained simply and clearly with

.....English.....English.....English.....English.....English.....English.....English.....English...

topics such as "Installing your
SIPROTEC device“, "Preparing
communication with DIGSI“,
"Monitoring, testing and controlling“
and "Replacing communication
modules“. Video clips show how to do
it. Details are explained by the
presenter and also shown in a text
field, with entertaining music in the
background. And best of all: this
useful CD-ROM is free!

How to get your SIPROTEC 4 StartUp

Order your free CD-ROM with order
No. E50417-A1174-C215-A1. Or just
write to us informally at
digsi@ptd.siemens.de.

http://siemens-russia.com/
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Presented
Customer Data Is All Important

Whenever a new DIGSI is ready for
release, our software development
engineers and testers are already
thinking about their long overdue
vacation, but the delivery group is
busy preparing for smooth shipment
of the software to all licensed
customers throughout the world.
Mr Posselt and Mr Wenzl won't now
even get a minute's breather
because their job is logistic and
technical clarification ahead of CD
production.They use checklists to
check questions such as: 

Is the package put together for the
delivery tests complete? Have the
CD-ROM booklet, inlet, and label
been updated to the new version
number? Is the press factory
informed? Are enough staff available
to handle shipment to 2500
recipients? On release of the new
DIGSI version, the CD master is
transferred to the press factory. It can
take 3 weeks for the mass-produced
CD-ROMs to arrive. However, orders
received in this periods are still
processed immediately.This is done

with a profession CD recorder with
an integrated label printer. The time
up until dispatch is used to prepare
customs and shipment documents.
"Some of these documents have to
be filled in by hand" is Mr Posselt's
complaint about obsolete regulations
hampering update processing.

When the CDs arrive from the press
factory, random samples are quickly
tested once again. If there is now no
obstacle to shipment, all forces are
mustered.The shipment pockets are
filled and labelled according to work
instructions. A database records
precisely which package is on its way
to whom. "We wouldn't want to
forget anyone", says Mr Wenzl who,
with his colleague, is responsible for
maintaining address database. And
actually nobody has ever been
forgotten. Nevertheless, customers
do sometimes call the service line,
annoyed because their haven't
received their update. But thanks to
meticulous data management,
enquiries are soon completed and
the reason found.The company has
been restructured and department
names and responsibilities have
changed. In such cases, software
packages may end up in the porter's
lodge, as happened 2 years ago in

Zurich. "Sometimes packages are
returned, or go astray en route",
Mr Posselt never tires of pointing out
how important it is to keep a record
of customer data. "That's what
decides where a shipped CD-ROM 
is going." The product manager
Reichenbach wants to change the
update procedure to ensure that
altered data is known and recorded.

Posselt and Wenzl are also respon-
sible for shipment of other software
products, such as SICAM plusTOOLS.
Their work is never dull, dealing with
the unexpected is fun. Customers
frequently seeking phone advice have
also noticed that. The service line is
easy to get hold of, and no wonder:
one of them is an early riser, the
other starts and knocks off late.

http://siemens-russia.com/
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Have you changed your address
data?

Just send an e-mail with your licence
number and the changed recipient
data to digsi@ptd.siemens.de.

To connect the circuit-breaker using
the feeder diagram of the SIPROTEC
unit, it is necessary to acknowledge
a few queries.To have the breaker
operated with a function key, users
have to think up some ingenious
safety mechanisms against acciden-
tal operation.

One solution uses two function keys
for safety.The first key switches to
control mode, the second sends the
actual switching command if pressed
within two seconds.

It's not hard to see how this is done:
The first function key starts a timer.
A signal is pending for 2s at timer
output QT1.This signal is ANDed
with the second function key.
If the second key is pressed within
the two seconds, the CFC output
"Command" is triggered.

There is a lot of demand for solutions
involving pressing the same function
key twice within a short time.

You might think you can take the first
solution and just replace the second

Hints & Tricks

key with the first. But you will soon
find that output "Command" goes
high the first time you press the
function key.The signal it sends is
applied to the timer and the AND at
the same time. How can we
eliminate the simultaneity and
implement a time sequence? The
solution is both simple and
ingenious: the AND must not run
second. Only if the logic gate is
running before the timer will the

second AND input and therefore its
output still be 0 the first time the key
is pressed. But now the timer is
running for 2s. If the function key is
pressed again, the required 1 is
applied to the AND the "Command"
output goes to "1".

http://siemens-russia.com/
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The fault recording analysis tool
SIGRA is based on the Comtrade
standard and therefore supports fault
records of other devices not
manufactured by Siemens. Here are
some tips on how to work better
with these fault recordings.

The user profiles already mentioned
in the previous edition are one of
SIGRA's most powerful functions.
You can use user profiles to store
your own layouts but also to simplify
working with other manufacturers'
fault recordings.

If you open a non-Siemens fault
recording, SIGRA asks whether the
signals of the fault recording have a
physical meaning. For SIPROTEC
devices, detection is automatic.

The assignment is used to identify
the signals for the analysis functions.
Only if you know the meaning of the
signals, can you calculate
impedances or power or symmetrical
components.The three-phase
currents are required to calculate the
zero phase-sequence system of the
currents in a three-phase system.
Only if it has these, can SIGRA
calculate the SIGRA and only then
will it also be offered in the routing
matrix.

Assign the signals of the fault
recording to the physical quantities.
The signals offered by SIGRA include
the phase and earth current, or the
phase-to-earth voltages and phase-
to-phase voltages. Missing quantities
of the three-phase system are
calculated as far as possible.

Then define a new user profile. Save
it under the name of the device.The
next time you open a fault record
from the device, you will no longer

have to assign the channels. Just
select the device's user profile.

If there are still signals missing that
you require for your analysis, you can
either find them in the routing matrix
or select one of the predefined user
profiles ("One Signal per Diagram" or
"One Signal Group per Diagram".
SIGRA then initialises the defined
diagrams again and adds important
quantities.

Ever had the problem that you
wanted to measure the maximum of
a curve but couldn't find the exact
spot because of the sinusoidal shape
of the signals? SIGRA 4.2 has the
solution for that too.

Right-click on the table view.The
context menu opens. Select "View
Properties...“.

In the dialog box that then appears,
select the measured value table you
want displayed.You will also find the
entry "Last extreme value" here.

Select it and place it in the list of the
selected columns.

The measured value table now
contains a new column that always
contains the last extreme value
(minimum or maximum), which is
displayed to the left of the cursor.
This is an easy way of finding local
maxima and minima.

If you work with the SIGRA profile
"One Signal per Diagram", you will
have encountered the problem that
after several zooming steps, the
diagrams have different axis scales.
One current diagram might go from
1.2A to 2A, another from -0.4 to 0.6.

If you want to standardise the scales
of all diagrams, there is a quick way
of doing it. Select menu item "Select
All" from the "Edit" menu, or press
<Ctrl>+<A>.Then
<Ctrl>+<Shift>+<A>“, or "Match"
under "Zoom" in the "View" menu. All
diagrams are now re-scaled to give all
axes the same scale.This function is

http://siemens-russia.com/
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also found in other views, for
example in the vector view or the
harmonics.

Do you want to enter a comment on
your fault record for documentation
purposes? SIGRA provides two ways
of doing that.

The Comtrade format includes a file
for comments.You can edit them
with SIGRA.You will find the relevant
"Comment" menu item in the "Edit"
menu.This text is printed out on the
first page of the fault recording. If you
want to enter more detailed

comments about a fault, there is
another method you can use. Place
cursor 1 on the position in the time
signal view where you want to attach
a comment. Select entry "Status
Signal" from the "Insert" menu.You
can now enter a short text. A mark is
set at the specified position in the
fault record.

This is a known error.You have to
open the copy/variant with DIGSI
once.Then the comparison will
provide the correct result.

I'm looking for a way of entering
certain menu levels in the device
with the function keys. I did not find
anything in the routing matrix.

DIGSI 4.40 finally provides a way of
assigning a front operation menu
level to a device function key.To do
that, open the allocation matrix of
the device.Then select "Function
settings" from the "Option" menu.
The following dialog then lets you
select the relevant function key from
the collapsible list. Tick the required
menu level below.

On some computers it is not
possible to start V2 device
processing (DOS-DIGSI). Under
Windows XP it even crashes.

This is because of an incorrect
setting of the underlying DOS
application under Windows. Open
the Explorer and select the file
"dosdigsi.exe" in path
x:\...\Digsi4\Digsi2 (x stands for the
drive on which DIGSI is installed).
Open the properties (right-click) and
set the idle sensitivity to "High"
under "Option". Under Windows XP,
also select the "Windows 95" option
on the "Compatibility" card.

I have set a variant of a device in the
manager. Although I have not
changed anything, the off/offline
comparison finds up to 1000
differences.

Questions & Answers
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Coming soon

The next DIGSI 4 notes

The next newsletter will appear in
December. Hints & Tricks will be
about applications with counters.
Remote communication with
SIPROTEC units of all versions will be
a further major topic. We shall then
introduce you to our communication
specialists.
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